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PRINCIPLES OF GEOMETRY 
G-MA 153 A 

McPherson College, Department of Mathematics, Fall 2015 
 
Note: Please remember we will not have class on Monday September 7.  Have a great Labor Day! 
 
Assignment #5 – First Lab: Intro to Geometer’s SKETCHPAD Software Due Friday, Sept. 11 
 
You will generally be given one week to do lab assignments.  If you are not able to attend a lab session please 
contact Mark Hunter, hunterm@mcpherson.edu, before the lab or as soon as possible after the lab so 
arrangements can be made to provide you with the materials required to complete the lab on time. 
 
For this lab you will use this set of instructions and the program CD provided to create two geometric drawings 
in the Geometer’s SKETCHPAD software.  You will copy these drawings to Microsoft Word and print them 
out with your name at the top of the page to turn in. 
 
Starting SKETCHPAD: 

Place the CD in the computer’s CD Drive and open the 
folder to view the files on the CD.  Start the 
SKETCHPAD program by double-clicking on the 
Sketchpad directory and then the “GSP 4.07S” file with 
the left mouse button.  

 
If you are not familiar with using a CD drive or starting 
a program by clicking on it then ask a neighbor for 
assistance. 

 

You will see this screen as the program opens.  Click anywhere 
in the white area of the document “untitled 1” to begin. 
 
You will find a set of buttons on the left side of the program 
window. 

The top button  is used to select objects in the drawing. 

The second button  is used to place single points. 

The third button  is used to draw circles. 

The fourth button  is used to draw line segments, lines, and rays. 

The fifth button  is used to create text and labels. 
The bottom button is used for custom tools which we will not use in this lab. 

There are menu selections across the top  
which we will also use during this exercise. 
 

You should maximize the program to your screen and maximize the drawing to the program window by 

pressing the maximize button in the upper right corners  
 

You are now ready to begin drawing.  Press CTRL-Z (hold down the Ctrl key and press Z) at any time to undo 
what you just did so you can retry it. 
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We will begin by drawing a square within a circle and calculate the ratio of their areas: 

Click on the button at the left to draw a circle then click in 
the center of the drawing area and move the mouse to the 
right while holding down the mouse button.  When the circle 
reaches nearly from the top to the bottom of the drawing area 
release the mouse.  This will draw a circle. 

You now need to change from drawing a 
line segment to drawing a line.  Click the 
mouse on the line segment tool and hold 

the mouse down 
to show the available selections.  
Move the mouse to the right and 

select the Line option.  Then draw a line between the red dot on 
the circle to the red dot in the center of the circle.  This will draw 
a diameter. 

Next select the single point tool  and click on the point 
where the line you just drew intersects with the left side of the 

circle.  Both the line and the circle should turn to a cyan color indicating that both are selected. 
Click on that point where they are both selected to place a point there. 

Now be sure to click on the selection button  then right click on 
the diameter line to bring up the attributes settings.  Select the Hide 
Line option in the list and watch the line disappear. 

Click and hold the mouse button on the line tool again to change it 
back to the line segment option. 

Once the line segment is selected, draw a line 
segment between the two points on the circle by 
clicking on one and then the other. 

After the line is drawn click on the selection 

button  then click on some open white space 
to de-select everything. 

It will often be important to click on open white space with the selection tool chosen to make sure that nothing is selected. 

Once nothing is selected, click on the center point of the circle so it is 
shown as selected then click on the line so that it is also selected.  
When both of them are selected, click on the Construct menu item 
and select Perpendicular Line.  This will draw a line that is 
perpendicular to the first diameter at the center 
point of the circle. 

Select the point tool  now and place points 
at the top and bottom intersections of this 
second diameter line with the circle.  
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Click on the selection button  then click on some open white space to de-select everything. 
Now click on the circle center point to select it, then click on the horizontal diameter line segment to select it, 
and finally click on the vertical diameter line segment to select it.  
When all three, and only those three are selected, click on the 
Display menu item and select Hide Objects. 

After the center point and diameters are hidden, select the line 

segment tool  and draw line 
segments between the four points on the 
circle to form a square as shown here: 

 
 
 
We now want to shade the interior of this square.  To do this you must deselect the sides (Click on the selection 

button  then click on some open white space to de-select everything) then select the four points at the 
corners of the square.  IMPORTANT: Select the points in a 
clockwise or counter-clockwise rotation around the square.  If 
you do not select them in the proper order then you will not 
properly shade in the square. 

Once all four corners are selected you should click on the 
Construct menu and select Quadrilateral Interior.  

This will shade the interior of the 
square.  

 

 

We now want to measure some areas 
and calculate the ratio of the area of the 
square to the area of the circle. 

Click on the selection button  then click on some open 
white space to de-select everything then click on the circle.  Next  

Click on the Measure menu item and select Area.  This will 
display the area of the selected circle on the drawing.  

 

Next de-select everything and then click on the yellow 
shaded area of the square to select it.  It will show up 
with a mesh pattern on it. 

Click on the Measure menu item and select Area again 
to display the area of the square on the drawing. 
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Area CBDE 

Area AB 
 = 0.64

Area CBDE = 93.26 cm2

Area AB = 146.50 cm2
C

D

E
B

We now have the area of the circle and the area of the square.  
Your areas will not match the areas shown here. 

Select the Measure menu item and select Calculate: 

 

 

 

 

to display the calculator: 

 

 

 

 

 

With the calculator displayed, click on  

Then press the “/” key 

Then click on  

 

Which will show up in the calculator as: 

 

Click the OK button and the final result 

will be placed on the drawing panel. 

 

Use the Edit menu and click 
Select All to select all of the 
visible object on the drawing. 

Then use the Edit menu and 
click Copy to copy the drawing 
to the clipboard (or use Ctrl-c).  

 

 

 

 

Create a Microsoft Word 
document with your name at 
the top then paste your work 
into that document (press Ctrl-v 
in Word). 
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Now that the drawing and measurements are complete and copied to Word you can try and move some of the 

points with the  tool selected.  You will notice that the areas change as the sizes change but the ratio does 
not. 

You are hopefully at least a little familiar with SKETCHPAD now so we will move on to the next exercise with 
a little less detail. 

Drawing Euler’s Line: 

In SKETCHPAD you should create a new drawing by selecting New Sketch from the File menu. 

 

Use the line segment tool  to draw a triangle.  You will draw a line on the 
drawing by clicking on one spot then clicking on another spot.  You then click 
on the point you just drew again and click elsewhere.  Finally you click on the 
point you just drew and click on the initial point. 

We will now find the middle of each side.  Make sure nothing is selected then 
select all three sides.  Select Midpoint from the Construct menu (or just press Ctrl-m) to place a point at the 
midpoint of all three sides. 

Circumcenter:  Intersection of  (perpendicular) bisectors 

De-select everything then select a single side and its midpoint.  Select 
Perpendicular Line from the Construct menu to draw a  line at the midpoint.  Repeat 

that for the other two sides.  Select the point tool  and place a point where these lines intersect. 

This is the circumcenter of a triangle and it is the center of the circle that passes through all three vertices of the 
triangle. 

Use the circle tool  to draw this circle.  Begin by clicking on the center you found then drag the mouse out 
to one of the triangle vertices.  It should pass through all three points of the triangle. 

Be sure to click on the select tool  as soon as you are done drawing the circle or else you will end up with 
extra circles all over your drawing (Ctrl-z to undo extra one.) 

Centroid: Intersection of medians. 

Draw line segments from each triangle vertex (each point) to the midpoint of the opposite side.  These lines are 
called medians. 

Select the point tool  and place a point where these lines intersect. 

Incenter: Intersection of ∡ bisectors. 

You may want to hide the perpendicular bisector and median lines.  Select the lines, press the right mouse 
button and select hide.  It will now be easier to see and draw the Incenter which is the intersection of the angle 
bisectors. 

Make sure everything is de-selected then select the topmost point of the triangle. Then select the next point of 
the triangle in a clockwise rotation. Finally select the third point. Select Angle Bisector from the Construct 
menu.  Repeat this beginning with second point and then repeat it again beginning with the original final point. 

Select the point tool  and place a point where these lines intersect. 
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Select the incenter point you just made and any side of the triangle.  With only these two objects selected use 
the Perpendicular Line from the Construct menu to draw a  line from the incenter to the side of the 

triangle. Select the point tool  and place a point at the intersection of the  line and the side of the triangle. 

Use the circle tool  to draw a second circle.  Begin by clicking on the center you found then drag the mouse 
out to point you just placed on the triangle.  There should now be a circle that always stays inside the triangle. 

Go ahead and hide the  line you just drew and the ∡ bisectors. 

Orthocenter:  Intersection of the triangle's altitudes. 

Select any side of the triangle and the point (vertex) opposite of it.  With only these two objects selected use the 
Perpendicular Line from the Construct menu.  Repeat this for the other two sides and you should end up 

with a new intersection.  Select the point tool  and place a point at this new intersection. 

Now hide the points that are on the triangle’s edges (midpoints and a few others but not the vertices.) You 
should have just three vertices and four floating points. 

Euler’s Line: 

Using the select tool , move the vertices to see how those four floating points move around.  You will notice 
that there are two that are sometimes outside the triangle.  Use the line segment tool to draw a line between 
these two points.  These points are the Circumcenter and Orthocenter.  You will now notice that as you move 
the vertices around now that one of the points, the Centroid, is always between those points on the line.  The 
Incenter does not lie on this line but it is always inside the triangle.  What is shown here is actually Euler’s 
Segment (Euler’s Line extends to infinity in both directions.)  We will discuss Euler’s line more in class. 

 

Completing the Assignment: 

Copy and Paste a copy of your drawing 

of the triangle, centers, circles, and Euler’s 

Segment into your Word file then print 

that file and turn it in at lab this week 

or next week. 

 

The CD: 

Please make sure you remove the CD from 

the lab computer.  Return the CD if you 

have completed the assignment.  You may 

take a CD with you and turn it in next week 

if you need additional time or assistance 

completing the assignment. 

 

I will be back on campus Friday afternoon. 


